
Welcome to the POWER-STAMP File Utility!
This utility was created for individuals who often want to Date/Time stamp files 
without going through a file-stamping utility integrated into another program 
such as check-in, check-out, version control packages.

Through the use of the POWER-STAMP File Utility you can select any file or files 
you wish, and apply either a Date and Time stamp, or set the attributes of a file or
files.

It was our goal to make this program as simple as possible while offering all the 
tools necessary to accomplish Date/Time stamping quickly and with a minimum of 
effort.

This version of the POWER-STAMP File Utility is a 30 day Timed Edition, offering 
you the opportunity to determine if this particular utility can be of any benefit to 
yourself or your organization.

For ordering information, please reference the document named "Order.Txt", 
which can be found in the location that you chose to install the POWER-STAMP 
File Utility.

To contact us by Mail, FAX, E-Mail, or telephone, you can find related information 
in the file mentioned above, or within the About-Box of the POWER-STAMP File 
Utility. 

For information about the Win 95 compliant version of POWER-STAMP, please 
contact VisaPower directly. Information on both the Win 95 version, and 
upgrades, will be shipped automatically to registered users of the POWER-STAMP 
File Utility. 

In Version 4.01 we have implemented the changes most often requested by users 
of the POWER-STAMP File Utility, and wish to express our continued dedication as 
relates to supplying products that are responsive to the consumers needs.

VisaPower would like to thank those individuals who have registered this product 
in good faith, resulting in this latest release.

This program was designed for Windows 3.1x.

See the following for a quick overview of available features:

Main-Menu Overview
Stamp-Panel Overview 
Calendar-Panel Overview 
Error Log-Panel Overview 
Attributes-Panel Overview 



Main-Menu
The POWER-STAMP File Utility offers a Main-Menu with the following menus:
File-Menu, Edit-Menu, Panel-Menu, Options-Menu, and Help-Menu.

The File-Menu allows the program to be exited, and previous work to be quickly 
resumed through the use of the available History-Menu feature.

The Edit-Menu allows for the selection, deselection, and refreshing of files 
displayed in the File List Boxes from within the Stamp-Panel, or the Attributes-
Panel.

The Panel-Menu allows you to quickly move between panels of the POWER-STAMP 
File Utility.
This task can also be accomplished through using either the panel tabs, or by 
using the Speed-Menu.

The Options-Menu lets you either toggle the Hints option on or off, or alter the 
speed with which processing performed upon files is accomplished.

The Help-Menu Brings up the Welcome screen of the POWER-STAMP File Utility 
Help-System.
Also available is the About-Box Menu item.

Items not appropriate within the current context will appear grayed.



File Menu
From the File Menu you can either exit the POWER-STAMP File Utility, or through 
the use of the available History feature, if you have used the utility prior to the 
current session, move to a directory previously worked in without going through 
the laborious process of selecting the directory manually.

The History item will not be visible when you first start the POWER-STAMP File 
Utility. An History item, or items, will be located underneath the Exit option after 
having re-entered the POWER-STAMP File Utility.
The last directory used prior to exiting the POWER-STAMP File Utility, and the last 
two prior to that, will be displayed, depending upon the number of previous 
accesses.
This feature will allow quick access to prior working directories, and hold up to 
three entries.

The history item/items, is/are, pulled from the Stamp-Panel.

Items not appropriate within the current context will appear grayed.



Edit Menu
Within the Edit Menu you can select, deselect, or refresh files displayed within the
File List Boxes found within either the Stamp-Panel, or the Attributes-Panel.

These Menu Items are available from both the Stamp-Panel or the Attributes-
Panel.

Items not appropriate within the current context will appear grayed.



Panel Menu
The Panel Menu offers Menu items allowing for movement between the POWER-
STAMP File Utilities Panels.

You can also move between panels by using their respective tabs, or by using the 
Speed-Menu.

Items not appropriate within the current context will appear grayed.



Options Menu
The Options Menu allows the Hints feature to be toggled on or off, and for the 
speed with which file operations are done to be adjusted.

Items not appropriate within the current context will appear grayed.



Help Menu
From within the Help Menu you can move to the Welcome screen of the POWER-
STAMP File Utility, or display the About-Box, showing information pertaining to 
the current release version, and numbers to use for contacting VisaPower.



Speed-Menu
The Speed-Menu can be accessed by depressing your right mouse-button, 
(Depending upon individual configuration) and will quickly move you between 
panels found within the POWER-STAMP File Utility.

You can also exit POWER-STAMP from within the Speed-Menu.

Items not appropriate within the current context will appear grayed.



Stamp-Panel Overview
By Selecting the Stamp-Panel from the POWER-STAMP File Utility, you can select 
Drives, Directories, and Files, with which to apply a Default, or Custom File-
Creation Date/Time Stamp.

The Date and Time with which the selected file or files are to be stamped will 
default to the current Date and Time as defined by your computers Date and Time
settings. Unless the Date and Time are edited by yourself, they will remain set to 
the current Date and Time set when you first launched the POWER-STAMP File 
Utility, and as defined by your computers settings at that moment.

By selecting the Stamp Push-Button , any files you have selected will be stamped 
to the Date and Time shown at the bottom left in the Date To Stamp, and the Time
To Stamp, edit fields. This operation can be canceled at any time by selecting the 
Cancel Push-Button .

If the file stamping operation encounters any difficulties in performing its task, 
the Status-Bar will display more detailed information of any errors encountered, 
and the Error Log Table will be updated for your reference, allowing for the 
possible correction of the condition or conditions which caused the error.

The current Date and Time, as defined by your computers system clock, is 
displayed and consistently updated, at the bottom right corner of the Stamp-
Panel.

The Progress-Gauge will keep you abreast of the progress of your file-stamping.

The Help! Push-Button will bring up the Stamp-Panel Overview screen of the Help-
System. The Calendar-Panel, Error Log-Panel, and the Attributes Panel, each have 
their own respective Help! Push-Buttons, that will result in Overview help topics 
being displayed, specific to the panel containing the push-button.

At the very bottom of the POWER-STAMP File Utility, is the Status-Bar used to 
provide you with information concerning the operation of the POWER-STAMP File 
Utility.
After having selected the Stamp Push-Button , a message giving you the statistics
of the total number of successfully stamped files will remain visible until you 
again select to modify a file or files from either the Stamp-Panel, Error Log-Panel, 
or the Attributes-Panel.

Also worth note is the offering of Fly-By-Help, giving you a brief description of the
purpose of the various components found within the POWER-STAMP File Utility.
This feature is accessed by placing your mouse cursor over the item in question, 
and reading the resultant Hint.

If the Fly-By-Help becomes an annoyance, you can toggle this feature on or off by 
using the available feature designated for this, and found under the Options-
Menu. If you currently have the Fly-By-Help toggled on, (The Default) then the 
caption on the button will read "Hint Off", conversely, if you have the Fly-By-Help 
toggled off, then the caption on the button will read "Hint On".
This setting will be saved for you between sessions, so as to alleviate the need to
repeat this process unnecessarily.



Directory List Box

The Directory List Box is located at the upper-left region of the Stamp-Panel, and 
the Attributes-Panel. From within this box you can view or select a Directory by 
selecting one of the available drives using your cursor-direction keys and enter 
key, or by double-clicking the desired Directory with your mouse.



Drive List Box

The Drive List Box is located at the upper-left region of the Stamp-Panel, and the 
Attributes-Panel. From within this box you can view or select a Drive by clicking 
on the down arrow to the right of the Drive List Box, and selecting one of the 
available drives using your cursor-direction keys and enter key, or by selecting 
the desired item with your mouse.



File List Box

The File List Box is located at the upper-middle region of the Stamp-Panel. and 
the Attributes-Panel. From within this box you can view or select a File, or Files, 
by scrolling and either clicking or dragging your mouse, using the cursor-direction
keys and enter key, or using the Select Push-Button.



File Filter List Box

The File Filter List Box is located directly below the File List Box, in both the 
Stamp-Panel, and the Attributes-Panel, and can be used to limit the display of 
files within the File List Box to a distinct type.

I.E. If you chose "Pwin All Source", you would be presented with a list of Paradox 
for Windows Source files, all other files would be hidden from view.



Operations Speed Scroll-bar

The Operations Speed Scroll-Bar is located below the File List Box and the File 
Filter List Box of the Stamp-Panel and has three settings, "Slow", "Medium", and 
"Fast". This feature can be of value in a situation where you wanted more time to 
read the Status-Bar messages, where setting the value to "Slow" would allow for 
an easier read.

If you were in a hurry, then you could set the value to "Fast".

This feature affects the speed of file operations of several screens. Those 
being...Stamp-Panel, Error Log-Panel, and the Attributes-Panel.

The speed of the Operations Speed scroll-bar can be adjusted from three different
sources, the first being the scroll-bar itself, the second being from the menu, and 
lastly you can use one of the following Hot-Keys:

Slow = <Ctrl+S>
Medium = <Ctrl+M>
Fast = <Ctrl+F>

"Medium" is the default value for the Operations Speed Scroll-Bar.

This setting will be saved for you between sessions, so as to alleviate the need to
repeat this process unnecessarily.



Stamp Push-Button

The Stamp Push-Button is found within the Stamp-Panel, and can be used after 
locating and selecting the file(s) you wish to Date/Time stamp, and will result in 
the stamping of Date and Time of the selected files.

If you should change your mind after having actuated the Stamp Push-Button, 
select the Cancel Push-Button to stop the processing of the selected files. You will
see the total number of successfully stamped files shown at the bottom of the 
POWER-STAMP File Utility in the Status-Bar.



Cancel Push-Button

The Cancel Push-Button applies to the Stamp-Panel, Error Log-Panel, and the 
Attributes-Panel. Actuating this push-button will immediately abort any file 
processing currently underway.

If you should change your mind after having started a file operation, select the 
Cancel Push-Button to stop the processing of the selected files. You will see the 
total number of successfully stamped files shown at the bottom of the POWER-
STAMP File Utility in the Status-Bar.



Help! Push-Button

The Help! Push-Button can be found on the following screens: Stamp-Panel, 
Calendar-Panel, Error Log-Panel, and the Attributes-Panel. Depending upon which 
screen you are on at the time, you will see a quick overview of the available 
functions of the applicable screen.

The Hint On/Hint Off Push-Button enables/disables the display of brief hints 
describing the purpose of the various components found within the POWER-
STAMP File Utility.

This setting will be saved for you between sessions, so as to alleviate the need to
repeat this process unnecessarily.

The Exit Push-Button will close the POWER-STAMP File Utility, and return you to 
Windows.



Select Push-Button

The Select Push-Button will highlight (Select) ALL files currently displayed in the 
File List Box,    located at the upper-middle region of the Stamp-Panel, and the 
Attributes-Panel.



De-Select Push-Button

The De-Select Push-Button will clear all highlighted (Selected) files currently 
displayed in the File List Box,    located at the upper-middle region of the Stamp 
Panel, and the Attributes-Panel.



Refresh Push-Button

The Refresh Push-Button will update the files currently displayed in the File List 
Box, located at the upper-middle region of the Stamp Panel, and the Attributes-
Panel.

This feature would be of value if the files in question have been modified outside 
of the scope of the POWER-STAMP File Utility since the initial file display was 
brought up.



Progress-Gauge

The Progress-Gauge is located within the Stamp-Panel, Error Log-Panel, and the 
Attributes-Panel, and is designed to keep you informed of the progress of 
operations performed upon a file or files.

The Progress-Gauge will increment from 1 percent to 100 percent, giving you a 
visual representation of the progress of any file operation.

The Progress-Gauge compliments the Status-Bar messages displayed at the 
bottom of the POWER-STAMP File Utility.



Date To Stamp Field

The Date To Stamp field allows you to enter any valid Date to be used for file-
stamping.

This field defaults to the current Date as defined by your computers system-clock,
at the time the POWER-STAMP File Utility is loaded.



Time To Stamp Field

The Time To Stamp field allows you to enter any valid Time to be used for file-
stamping.

This field defaults to the current Time as defined by your computers system-clock,
at the time the POWER-STAMP File Utility is loaded.



Current Date And Time Status

The Current Date and Time section is located at the bottom-right of the Stamp-
Panel. These values are derived from the current system-clock settings of your 
computer, and are updated regularly.



Status-Bar

The Status-Bar supplies information pertaining to the status of any operation 
performed upon a file or files.

You will see the total number of successfully processed files shown at the bottom 
of the POWER-STAMP File Utility, within the Status-Bar, during and after any file 
processing.

The Status-Bar compliments the Progress-Gauge percentage displayed within the 
Stamp-Panel, Error Log-Panel, and the Attributes-Panel screens.



Getting Around

Any item with text containing an underlined character that you see within the 
POWER-STAMP File Utility, excepting the main-menu, can be accessed by pressing
the underlined characters key from the keyboard.

To open a pull down menu from the main-menu simply hold down the <Alt> key, 
and simultaneously press the underlined characters key from the key board.
Once the pull down menu is displayed, you can use the underlined characters 
from within the open pull down menu without using the <Ctrl> key.

Hints, and the Operations Speed Scroll-Bar can also be adjusted by holding down 
the <Ctrl> key, and simultaneously pressing the underlined character available 
for each particular setting.



Context-Sensitive Help

Context-Sensitive Help is available by simply pressing the <F1> key. Depending 
on the particular item that is currently selected, the POWER-STAMP File Utility 
Help-System will be loaded, and the topic applicable for the currently selected 
item will be shown.

I.E. If you had previously used the Stamp Push-Button, or you had moved to it, 
then by pressing the <F1> key, the topic specifically addressing the Stamp Push-
Button would be automatically selected for you.



Hints

This feature is access by placing your mouse cursor over an item. The item under 
your mouse cursor will display its specific Hint, briefly describing the function of 
the item directly beneath the cursor.

If the Fly-By-Help becomes an annoyance, you can toggle this feature on or off by 
using the available feature designated for this, and found under the Options-
Menu. If you currently have the Hint toggled on, (The Default) then the caption on
the button will read "Hint Off", conversely, if you have the Hint toggled off, then 
the caption on the button will read "Hint On".

This setting will be saved for you between sessions, so as to alleviate the need to
repeat this process unnecessarily.



Calendar-Panel Overview
By Selecting the Calendar-Panel from the POWER-STAMP File Utility, you can 
select various Dates to verify, or apply the selected date for use in the Stamp-
Panel.

The current Month can be changed by using the Month Spin-Button to adjust the 
Month currently displayed within the Month Field.

The current Year can be changed by using the Year Spin-Button to adjust the Year 
currently displayed within the Year Field.

The Calendar can be used to view or change the current Day.

The Use Push-Button can be used to set the Stamp-Panel, Date To Stamp field, to 
the Date currently displayed within the Calendar-Panel.

The Reset Push-Button can be used to reset the Calendar-Panel Date to the 
current Date as defined by your computers system-clock.

The Help! Push-Button will bring up the Calendar-Panel Overview screen of the 
Help-System. The Stamp-Panel, Error Log-Panel, and the Attributes Panel, each 
have their own respective Help! Push-Buttons, that will result in overview help 
topics being displayed, specific to the panel containing the push-button.



Month Field
This field can be found within the Calendar-Panel.

The Month field displays the month that the Calendar is currently synchronized 
with.

This value can be altered by clicking on either the up or down arrow of the Month 
Spin-Button.



Year Field
This field can be found within the Calendar-Panel.

The Year field displays the year that the Calendar is currently synchronized with.

This value can be altered by clicking on either the up or down arrow of the Year 
Spin-Button.



Month Spin-Button
This field can be found within the Calendar-Panel.

The Month Spin-Button changes the Month displayed in the Month Field, and 
synchronizes the Calendar with the selected Month.



Year Spin-Button
This field can be found within the Calendar-Panel.

The Year Spin-Button changes the Year displayed in the Year Field, and 
synchronizes the Calendar with the selected Year.



Calendar
This display can be found within the Calendar-Panel.

The Calendar is initialized upon opening the POWER-STAMP File Utility, and is set 
to the current Date as determined by the system settings of your computer.

The Month Spin-Button, and the Year Spin-Button can be used to alter the 
calendars setting.

The Day will be adjusted based on the current Date Selected, and the values 
selected in both the Month Field, and the Year Field.



Use Push-Button

This field can be found within the Calendar-Panel.

The Use Push-Button will set the Date To Stamp field    edit field found within the 
Stamp-Panel to the value currently displayed by the Calendar-Panel.



Reset Push-Button
This field can be found within the Calendar-Panel.

The Reset Push-Button will reset all of the Calendar settings to the current Date, 
as determined by the system settings of your computer.



Error Log-Panel Overview
By Selecting the Error Log-Panel from the POWER-STAMP File Utility, you can view 
details of the files that could not be Date/Time stamped from the Stamp-Panel, or 
where attributes could not be set from the Attributes-Panel.

In general, files entries will be entered in the Error Log Table because of attribute 
settings disallowing the Date/Time stamping of same, or file sharing difficulties. In
the case of the former, you can adjust attributes within the Error Log-Panel, or 
move to the Attributes-Panel to view, or change attributes when necessary.

The Error Log-Panel has the following available features.

At the top you will find the Navigation-Bar which allows you to move through the 
Error Log Table.    Through the use of the Navigation-Bar you can move forward or 
backwards one record at a time, move to either the top or bottom of the table, 
cancel an attribute change, or delete an entry.

Below the Navigation-Bar is the Error Log Table which displays a check-box to the 
left, and to the right of that, the path, filename, and extension, of files that failed 
either Date/Time stamping, or Attributes setting. The check-box will be un-
checked when a file entry is first added to the Error Log Table, and will be checked
when an attempt to change the attributes of the respective file or files transpires,
and is successful.

Below the Error Log Table is the Error Log-Panel Progress-Gauge. This feature will 
visually display the progress when attempting to alter attributes of items 
displayed in the Error Log Table.

Below the Progress-Gauge are two fields, showing the date and time of the file 
operation failure, and a couple of check-boxes that indicate whether the selected 
file originated from an error within the Stamp-Panel, or from the Attributes-Panel.
These items change as you scroll through, or select a file, from the Error Log 
Table.

The row of five check-boxes near the bottom, display the attributes of the 
currently selected file in the Error Log Table, or allow the selection of attributes to
be set using the Apply Push-Button.
Attributes can be set on an entry by entry basis. Simply select an entry, and set 
its attributes. You can also batch set attributes by scrolling through the Error Log 
Table, and selecting the desired attributes for each entry, and then using the 
Apply Push-Button to change the pertinent file or files attribute or attributes.

The ability to view and modify attributes such as "System", and "Read-Only" has 
been made available as of this release, (Version 4.01) and while it should be a 
useful feature, great caution must be taken whenever working with "System" and 
"Read-Only" settings.

The Apply Push-Button will set all files in the Error Log Table to the attributes 
defined for each individual entry. If an attribute for a particular entry has not 
changed, then it will be ignored during the set process, but included in the 
statistics count    displayed in the Status-Bar., and as indicated by the row of five 
check-boxes towards the bottom of the panel.

The Cancel Push-Button will cancel the setting of file attributes started with the 



use of the Apply Push-Button.

The Empty Push-Button will empty the Error-Log Table.

The Help! Push-Button will bring up the Error Log-Panel Overview screen of the 
Help-System. The Stamp-Panel, Calendar-Panel, and the Attributes Panel, each 
have their own respective Help! Push-Buttons, that will result in overview help 
topics being displayed, specific to the panel containing the push-button.

At the very bottom of the POWER-STAMP File Utility, is the Status-Bar used to 
provide you with information concerning the operation of the POWER-STAMP File 
Utility.
After having selected the Apply Push-Button , a message giving you the statistics 
of the total number of successfully set files will remain visible until you again 
select to modify a file or files from either the Stamp-Panel, Error Log-Panel, or the
Attributes-Panel.

Also worth note is the offering of Fly-By-Help, giving you a brief description of the
purpose of the various components found within the POWER-STAMP File Utility.
This feature is accessed by placing your mouse cursor over the item in question, 
and reading the resultant Hint.

If the Fly-By-Help becomes an annoyance, you can toggle this feature on or off by 
using the available feature designated for this, and found under the Options-
Menu If you currently have the Fly-By-Help toggled on, (The Default) then the 
caption on the button will read "Hint Off", conversely, if you have the Fly-By-Help 
toggled off, then the caption on the button will read "Hint On".
This setting will be saved for you between sessions, so as to alleviate the need to
repeat this process unnecessarily.



Navigation-Bar
The Navigation-Bar is used within the Error Log-Panel to work with entries in the 
Error Log Table.

Through the use of the Navigation-Bar you can move forward or backwards one 
record at a time, move to either the top or bottom of the table, cancel changes to 
an entry, or delete an entry.



Error Log Table
The Error Log Table is found within the Error Log-Panel, and displays a check-Box 
to the left, and to the right of that, the path, filename, and extension, of files that
failed either Date/Time stamping, or Attributes setting. The check-box will be un-
checked when a file entry is first added to the Error Log Table, and will be checked
when an attempt to change the attributes of the respective file or files transpires,
and is successful.



Date of Error Field
This field is found within the Error Log-Panel, and indicates the Date when an 
error occurred during either Date/Time stamping of a file or files, or setting a file 
or files attribute(s).

Each entry in the Error Log Table has its own identifying Date, set when the 
record was added to the table.



Time of Error Field
This field is found within the Error Log-Panel, and indicates the Time when an 
error occurred during either Date/Time stamping of a file or files, or setting a file 
or files attribute(s).

Each entry in the Error Log Table has its own identifying Time, set when the 
record was added to the table.



Error Source Group Box
This group is found within the Error Log-Panel, and contains two check-boxes. If 
the source of the error was the Stamp-Panel, then the check-box titled "Stamp" 
will be checked, if the source of the error was the Attributes-Panel, then the 
check-box titled "Attribute" will be checked.

Each entry in the Error Log Table has its own error source identifying tag, set 
when the record was added to the table.



Attributes Check-Box Bank
The Attributes Check-Box Bank is found within the Error Log-Panel, and the 
Attributes-Panel.

When selecting a file from the File List Box within either of the above-mentioned 
screens, the Attributes Check-Box Bank will be updated to reflect the attributes of
the selected file or files (See below).

These check-boxes can be set manually in order to change attributes for various 
files.

From the Error Log-Panel, changing the attributes and then actuating the Apply 
Push-Button will result in ALL files currently within the Error Log Table being set 
to the selected attributes.

From the Attributes-Panel, changing the attributes and then actuating the Apply 
Push-Button will result in the selected file, or files, being set to the selected 
attributes.



Apply Push-Button
The Apply Push-Button can be found within both the Error Log-Panel, and the 
Attributes-Panel.

From the Error Log-Panel, actuating the Apply Push-Button will result in ALL files 
currently within the Error Log Table being set to the selected attributes.

From the Attributes-Panel, actuating the Apply Push-Button will result in the 
selected file, or files, being set to the selected attributes.



Empty Push-Button
The Empty Push-Button can be found within the Error Log-Panel, and will result in 
the deletion of any entries in the Error Log Table.



Attributes-Panel Overview
By Selecting the Attributes-Panel from the POWER-STAMP File Utility, you can 
view or modify the attributes of the file or files you select.

The Attributes-Panel can be of great benefit when working with files within the 
Stamp-Panel, or attempting to determine and or correct conditions that have 
resulted in an entry or entries being added to the Error Log Table. 

The Attributes-Panel has the following available features.

The Attributes-Panel Progress-Gauge. This feature will visually display the 
progress when attempting to alter attributes of any selected file or files displayed
within the File List Box.

The row of five check-boxes near the bottom display the attributes of the 
currently selected file or files in the File List Box, or allow the selection of 
attributes to be set using the Apply Push-Button.
The ability to view and modify attributes such as "System", and "Read-Only" has 
been made available as of this release, (Version 4.01) and while it should be a 
useful feature, great caution must be taken whenever working with "System" and 
"Read-Only" settings.

The Apply Push-Button will set any file or files select within the File List Box to 
the attributes displayed/Selected in the row of five check-boxes towards the 
bottom of the panel.

The Cancel Push-Button will cancel the setting of file attributes started with the 
use of the Apply Push-Button.

The Help! Push-Button will bring up the Attributes-Panel Overview screen of the 
Help-System. The Stamp-Panel, Calendar-Panel, and the Error Log-Panel, each 
have their own respective Help! Push-Buttons, that will result in Overview help 
topics being displayed, specific to the panel containing the push-button.

At the very bottom of the POWER-STAMP File Utility, is the Status-Bar used to 
provide you with information concerning the operation of the POWER-STAMP File 
Utility.
After having selected the Apply Push-Button , a message giving you the statistics 
of the total number of successfully set files will remain visible until you again 
select to modify a file or files from either the Stamp-Panel, Error Log-Panel, or the
Attributes-Panel.

Also worth note is the offering of Fly-By-Help, giving you a brief description of the
purpose of the various components found within the POWER-STAMP File Utility.
This feature is accessed by placing your mouse cursor over the item in question, 
and reading the resultant Hint.

If the Fly-By-Help becomes an annoyance, you can toggle this feature on or off by 
using the available feature designated for this, and found under the Options-
Menu If you currently have the Fly-By-Help toggled on, (The Default) then the 
caption on the button will read "Hint Off", conversely, if you have the Fly-By-Help 
toggled off, then the caption on the button will read "Hint On".
This setting will be saved for you between sessions, so as to alleviate the need to
repeat this process unnecessarily.





About-Box
By Selecting the About-Box from the POWER-STAMP File Utility Menu, you can 
view information pertaining to the version of the POWER-STAMP File Utility you 
currently have installed, as well as information on how our company can be 
contacted.




